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ROUND 1064 AD, ACCORDING TO TREE-RING

DATING, SUNSET CRATER ERUPTED NORTH OF

MODERN-DAY FLAGSTAFF, ARIZONA. THE ERUP-

.' i}
TION LEFT A BLANKET OF CINDERS AND ASH ACROSS THE
HIGH DESERT REGION, INCLUDING THE AREA NOW BOUNDED

By WuPrATKI NATIONAL MONUMENT. THESE DEPOSITS MADE

LIMITED FARMING POSSIBLE AND ATTRACTED A MELTING POT OF
CULTURES TO THE PREVIOUSLY UNINHABITED AREA. IT IS ESTIMAT-
ED THAT SEVERAL THOUSAND PEOPLE LIVED IN THE AREA DURING
THE 12TH CENTURY UNTIL SOIL FERTILITY GAVE OUT. WUKOK! 1S
ONE OF SEVERAL ANASAZI AND SINAGUA STRUCTURES DOTTING THE

AREA (Fi6

We'll use both World Construction Set (WCS) and LightWave to recreate
the Wukoki pueblo during the occupation stage and illustrate how the two
applications can streamline workflow. In the first part, we'll create the land-

scape with WCS. In next issue's conclusion, we'll build the pueblo with LW

and composite it in WCS.

The terrain data we need is freely available on the web from the USGS and
GIS Data Depot. Links to the data used in this tutorial, as well as reference
images, full-size figures and WCS Components, can be found on my site at
www.cherba.com/resource. Download the Componentszip file and copy the
uncompressed contents to your WCS\Components folder. 10-meter resolution
SDTS DEMSs will form the basis of the near landscape around Wupatki and 90-
meter USGS ASCII DEMs will provide surrounding ground and skyline. That
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| Database Edit

Figure 2. Database Editor, flagstaff-w.K DEM selected

Figure 3. Plan view with DEM hole

means good detail nearby and fast rendering
distant terrain. When | refer to10-meter and
90-meter resolution, that's the spacing of
data points on the terrain grid. The same
DEMs may be referred to as 75-minute and
1-degree DEMSs, respectively, which refer to
the geographic arc the DEMs cover.

Uncompress the USGS ASCIl DEMs,
flagstaff-egz and flagstaff-w.gz, before
import. Launch the Import Wizard and load
flagstaff-e. When asked if you'd like to import
another DEM, load flagstaff-w using the
default settings. WCS will automatically tile
each 1-degree DEM into sixteen 15-minute
DEM tiles. WCS subdivides most DEM types
into tiles during import. If any portion of a
DEM is in camera view at render time, WCS
makes render calculations for the entire
DEM. Many smaller DEM tiles reduce unnec-
essary render time.

Disable the flagstaff-wK DEM in the

Database Editor (Figure 2). This hole is
where the four 10-m SDTS DEMs will soon

KEYFRAME

fit (Figure 3). When you download the SDTS
DEMs, name them by something identifiable
like quadrangle and resolution, eg., Gray
Mountain AZ 10mtargz Leave the targz
extension so WinZip knows to ungzip and
untar the archive. To prevent WinZip from cor-
rupting the data, go to Options >
Configuration > Miscellaneous and deselect
"TAR file smart LR/LF conversion." Extract
compressed files to separate folders.

Launch the Import Wizard again and load one
of the Gray Mountain DDF files. It doesn't
matter which one you pick, the Wizard will fig-
ure it out. When the Wizard asks if you want
to import ancther DEM, choose one of the
Woupatki NE DDFs. Repeat the process with
the Wupatki SE and Wupatki SW data, WCS
will create a single .elev DEM on import
because it has to fill in the gaps between
SDTS DEMs. Always import SDTS data
together this way or you'll end up with notice-
able breaks along dataset boundaries. Start
the Import Wizard once again and load GRAY
MOUNTAINelev. Name it Wupatki in the
QUTPUT FILE TYPE AND NAME window.
When you get to the DATA POSITIONING
window, Change Settings.

You don't know it yet, but we're going to have
a problem. Whenever you drop high-resolu-
tion data into holes in lower resolution terrain,
you're going to have elevation gaps along the
boundary. No matter how good your data is,
it's just a fact of life that data points border-
ing a 90-m grid don't meet all the points

along a 10-m grid. We'll use an old trick that's
been around since early motion picture days
and head off the problem early.

Continue to the Import Wizard VERTICAL
EXTENTS window. The Elevation Modifier
adjusts high and low elevation data by the
same amount. Enter 50 to increase all
imported data by 50 meters (Figure 4). Test
imports and renders | did while developing
the project showed elevation gaps of up to
40 meters. Fifty meters should raise our 10-
m DEM high enough so we don't see any
daylight under the surrounding 90-m DEM.
Although it's not an issue with this project,
keep in mind that this method changes the
actual terrain data elevations.

Continue to the fifth window, OUTPUT
DEMS, and change DEM Row-Wise and
DEM Col-Wise to 2 (Figure 5). This will give
us four DEMs with areas matching the Gray
Mountain, Wupatki NE, Wupatki SE, and
Wupatki SW DEMs we originally imported.
When the Wizard is done, disable the GRAY
MOUNTAIN DEM in the Database Editor.
Use the Label button to relabel the DEMs
according to their USGS quadrangle name
(Figure 6). WupatkiA is Wupatki SW,
WupatkiB is Gray Mountain, WupatkiC is
Waupatki SE, and WupatkiD is Wupatki NE.
This will make it easier to identify the DEMs
and will simplify draping the DRGs. Run the
Import Wizard one last time and multiple-
select the WupatkiA, WupatkiB, WupatkiC,
and WupatkiD elevation files. Import using
the default settings. This will tile them
to a size appropriate for rendering.

Figure 4. VERTICAL EXTENTS window
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DRGs (Digital Raster Graphics, or dig-
ital topographic maps, if you wil)
make great references for placing
features on terrain. Fortunately,

Figure 5. OUTPUT DEMS, and change DEM
Row-Wise and DEM Col-Wise to 2 1
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Figure 7. Image Object Library Gray Min GeoRef page and DBE Gray Mtn
selected while Snap to DEM clicked.

Figure 9. Gray Mtn Color Map Editor, select in dropdown.
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Arizona DRGs are available free for download from the
ARIA server at the University of Arizona in Tucson. The
1:24,000 scale DRG maps come in regular and decol-
lared versions. The decollared versions have the map bor-
der and legend removed, so they!ll save you a trip to
Photoshop. On download, name them by quadrangle and
type, eg, Gray Mountain DRG DCtif (DC stands for
decollared). Open the Image Object Library, Add Image
Object, and load the four DRGs. The PC version allows
you to multiple-select all four images for loading. Select
the Gray Mountain DRG DCUif and Add Geo Reference
Aftribute. Select the Gray Mountain DEM in the Database
Editor (the one you just labeled) and click Snap to select-
ed DEMs in the Image Object Library (F 7). WCS will
remind you of the process; OK to complete the snap. The
latitude and longitude bounds will update. Repeat the
process and georeference the remaining DRGs. The four
quadrangle-named DEMs have served their purpose, so
disable them in the Database Editor (Figure 8).

In the Land Cover Task Mode, create four Color Maps and
name them Gray Mountain, Wupatki NE, Wupatki SE, and
Wupatki SW. Choose Color by Pixel to render all of the
image detail and load the corresponding DRGs from the
Image Object dropdown list

Go to the Render Task Mode and open the Component
Gallery. Open the Cameras page and select the
Keyframe32 tab. Load the Wukoki Plan Camera and
open a view. Do not scale the loaded camera's position to
current DEM bounds; we want it loaded right where it
was originally created. Disable Atmospheres and key F9
to render a preview (Figure 9). Wukoki ruin is almost
directly below us. We're done with the Color Maps, so dis-
able them. Go back to the Render Task Mode, right-click
the Cameras category in the Scene-At-A-Glance, and
Add Component from Gallery. Flip to the Keyframe32 tab
and load the Wukoki View SW Camera. Do not scale the
loaded camera's position to current DEM bounds. Open a
view.,

Go to the Land Cover Task Mode, right-click the Ground
Effects category and Add Component from Gallery. Go to
the Cartography tab and load the GrnBrnGryWht
Hypsographic Ground Effect. Turn to the Ground Editor
Material Gradient & Driver page. Scale the Material
Gradient Driver from 1440 fo 1460 meters. Expand the
Ground Effects category in the Scene-At-A-Glance. We
can only have one global Ground Effect, so rather than let
WCS choose one for us, enable GrnBrnGryWht
Hypsographic only. Open the Terrain Parameter Editor
from the lower Scene-At-A-Glance pane and increase
the Maximum Fractal Depth to 5. Render a Wukoki Vew
SW preview to get an idea of the topography (Figure 10
The knob left of center is where we'll build the Wukokl
pueblo.

The ground here is the Moenkopi Formation of early
Triassic age and is the next geologic unit up in the
sequence exposed in the Grand Canyon to the northwest.
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These are terrestrial deposits of reddish
sandstones (resistant cliffs) and mudstones
(slopes). Select the Ground Effects category
in the Scene-At-A-Glance and Add
Component from Gallery. Go to the
Keyframe32 tab, load the Wupatki NM
Colors Ground Effect, enable it, and disable
the others. Render a Wukoki View SW pre-
view (Figure 11). Bright colors are great for
quickly setting up Ground Effects.

Let's see how the Wupatki NM Colors
Ground Effect places materials on the terrain.
Select the Texture Operations button to the
right of the Material Gradient Driver % field
and Edit Texture. The Texture Editor uses an
Elevation-driven Dynamic Parameter Texture
to place materials in the gradient. The gradi-
ent goes from 1430 meters to 1550 meters.
Materials are rendered according to their
position in the gradient, in this case, elevation.
Go to the Render Task Mode and load the
Wukoki Zoom Camera from the Component
Gallery Keyframe32 tab. Do not scale the
loaded camera's position to current DEM

Wukoki Zoom - Wukaki Préview Optians

bounds. Open a view and render a preview. If
you click on the base of Wukoki's rocky knoll
in the preview render, the Diagnostic Data
gives an elevation of about 1452 meters
Figure 12). This is where we want Moenkopi
5 Cliff material to start rendering. 1452
meters is about 18.3% along the 120-m gra-
dient 185% was used because the Half
Blend transition will slightly lower where the
Moenkopi b Cliff starts rendering (f

The Cliff materials will be cliff formers (small
though they may be) and Slope materials will
form slopes. Unfortunately, the 10-m terrain
data shows everything as slopes. We'll use
Area Terraffectors to raise some cliffs, but
let's first increase the resolution of this DEM
to 1 meter. Several iterations of the DEM
Interpolater would work, but the Import
Wizard will do it in one step and we can
resample the DEM at a resolution of our
choosing. Import the foreground DEM,
Wupatki CG. When you get to the DATA
POSITIONING window, Change Settings.

General Material Gradient & Driver | Material |

S Diagnostic Data

Component  [Wupatki NM Colors v
Distance 2} [465.762817m e
Latitude: [35.5311367° .
Longitude: |111.328625* )
Elevaion [EEEEEER ¢
RelEL |-7.92 ”
Slope: |24.0663586° .
Aspect [3BSSEHT |
 Reflection: [0.0% -
luminatior: 45 4% r
Mormal XYZ: |-0.432, 0.840,0.329 »
RGB/HSY: [3552,30 /106,42.20 o
Alpha: !255 -

AE =z

Continue to the fifth window, OUTPUT
DEMS, and increase Output Cols and Output
Rows by a factor of 10 to 2830 and 2780.
The cell size will drop to about a meter. Import
the data and disable the 10-m Wupatki C.G
DEM we just resampled.

Render another Wukoki View SW preview
and you'll see a smooth and more detailed 1-
m terrain (Figure 14). We weren't looking for
more realistic resampled terrain. Our goal
was to have a finer grid for applying an Area
Terraffector Elevation texture. To make life
easier later on, multiple-select all Wupatki
C.G! DEMs in the Database Editor and add
them to a 1m DEMs layer (Figure
Disable the layer. Multiple-select the remain-
ing active DEMs and WupatkiC.G and add
them to an Active DEMs layer. Disable the
layer. Multiple-select the DEMs in the imme-
diate area of Wukoki (Wupatki C.GBP, BQ,
BR, BZ, CA, and CB), add them to a Wukoki
DEMs layer, and enable the layer. Open the
Wukoki Plan view and scale it so all DEMs
are in VIEW 1}

Area
Terraffectors

— Material Gradient & Driver

L mnk = [

™ Make Entire Ground Transparent

Material Gradient Driver (%10 3] 2|1

raise or lower
terrain within an
area defined by

il B ]

a vector. Our
vector will bound
1430mf3] [1550m}=] the six DEMs.

For extra credit,
you can use my

X

Postion in Gradient (%[185_[5] 8] [HalrBlend 7]

|Maenkopi 5 Cliff

Moenkopi 4 Slope

Cinders

Moenkopi 3 Clff |

Moenkopi 5 Clif §
Moenkopi & Slope
-

Elev1448m and
Elev14b53m
Ground Effects
to render
grayscale plani-
metric views to
disk where ele-
vations above

= % ke

18]
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Figure 14. Wukoki View SW render with 1-m grid DEM

Figure 16. Plan OpenGL, W
CB DEMs only

Vupatki SE.G.BR, BQ, BF, BZ, C

14485 and 1453 meters, respectively, are white and elevations
below aren't You can then open the renders in an image editor to
create irregular cliff outlines. Or you can use my Elev1448 and
Elev1453 images where I've done all the work for you. I'm going
for a stylized terrain look, so there are no sharp corners on my cliff
texture maps (Figure 17). Add the Elev1448iff and Elev1453iff
images to the Image Object Library and add Geo Reference
Attributes. Select the Wukoki DEMs layer i in the Database Editor
and snap the image bounds to the DEMs (Figure 18)

Go to the Terrain Task Mode, select the Area Terraffector catego-
ry in the Scene-At-A-Glance, and Create from the icon toolbar.
Click the four corners of the terrain in the Wukoki Plan view to
define the bounding vector, starting with the upper left comer.
Right-click when you're done and name the Area Terraffector and
vector Elev1448. Close the Component Gallery when it opens. We
could stop here and say the vector's close enough, but | don't want
you to get into any bad habits. Alt+click the vector in the plan view
to activate it and Show Points from the toolbar. Double-click the
vector in the view to open its Vector Editor. Go to the Selected
Points page and select Single Point. As you click the up arrow wid-
get beside the First field you'll see the active points in red in the
plan view.

Open the Image Object Library, select one of the Elev images, and
tumn to the Geo Reference page. The first vector point should

JA, and
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Figure 17. Elev1453.iff

match the upper left corner. Highlight the Top value on the Geo
Reference page, Ctrl+C to copy, and paste it into the Y (Lat N-S)
field in the Vector Editor. Highlight the Left value and copy it to
the X (Lon W-E) (Figure 19). You'l see the point nudge in the
view as new values are entered into the Vector Editor. Repeat the
process for the remaining points according to the following table.
Before we leave the Vector Editor, Create Copy and name it
Elev1453,

Y (Lat N-S) X (Lon W-E)
Point 1 Top Left
Point 2 Top Right
Point 3 Bottom  Right
Point 4 Bottom Left

Go to the Area Terraffector Editor > Elevation & Roughness page
and make the elevation Absolute and Increase Only. Enter an
Elevation of 14485 and create ayWe'll use an image to drive the
texture, so select Planar Imagé™as & Selected Element and
choose the Elev1448iff from the Image Object dropdown list
The image is already georeferenced, so we're done. Clone the
Elev1448 Area Terraffector in the Scene-At-A-Glance and name
it Elev1453. Go to its Elevation & Roughness page and change
the Elevation to 1453. Edit the texture and choose the
Elev1453iff from the Image Object dropdown list Expand the
Vectors category in the lower Scene-At-A-Glance pane. Click,
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Drop Elev1 ctor on Elev
drag and drop the Elev1453 vector on the
Elev1453 Area Terraffector (Figure 20). We
now have cliffs set up at elevations of 14485
and 1453 meters.

Refere

Vukoki DEMSs layer

In the Database Editor, activate the Wukoki
DEMs layer, and Disable. Select a member of
the Active DEMs layer (eg, WupatkiAT),
activate the Active DEMs layer, and Enable.
Go to the Land Cover Task Mode and load
the Wupatki NM Ground Effect from the
Component Gallery Keyframe32 tab. Make it
the only enabled Ground Effect. This is a tex-
tured version of the Wupatki NM Colors
Component we've been using. It uses Fractal
Noise textures stretched in the terrain XY
plane (XZ in the LightWave world) for Diffuse
Color and Bump Texture to simulate the strat-
ified sedimentary rock of the Moenkopi
Formation. Turn Atmospheres back on and
render a Wukoki Vew SW preview to admire
your handiwork (f 1)

That takes care of the ground. Now for the
Ecosystems. Load the Boreal WNM and
Upper Sonoran-Pinyon WNM Ecosystems
from the Component Gallery Keyframe32
tab. Do not scale the loaded Ecosystem ele-
vation lines to the current DEM elevation.
Open the Environment Editor to the
Ecosystems page and Grab All. The Upper
Sonoran-Pinyon WNM Ecosystem should be
first in render order. If it isn't, select it and use
the red up arrow to increase its render prior-
ity. These are northern Arizona Ecosystems
that use stock WCS images, so don't look too
closely or you'll see that the desert scrub
bushes aren't really creosote. If you were to
render the scene as is, it would take almost
two hours. That's because WCS would ren-
der each foliage obiject (in this case, image)
as far as the camera can see.

When you have an expansive scene like this,
rendering each foliage image is usually time
wasted since it's nearly impossible to discern
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image detail in distant foliage. That's where
Distance Dissolve comes in. It replaces the
Ecotype Foliage Objects with Dissolve Color
when the objects drop below a rendered pixel
height. Go to the Boreal WNM Ecosystem
Editor > Material & Foliage page. Select the
Overstory Ecosystem Operations button and
Edit Ecotype. Turn to the Ecotype Editor >
Ecotype page, select Dissolve Enabled, and
add a texture. Load Complete Texture in the
Texture Editor. Go to the Component Gallery
Keyframe32 tab and load the Boreal
Dissolve Texture (Figure 22). Do the same for
the Understory Ecotype; enable Dissolve, add
a texture, and load the Boreal Dissolve
Texture. Page to the Upper Sonoran-Pinyon
WNM Ecosystem Editor, repeat the process
for its Ecotypes, and load the Upper
Sonoran-Pinyon Dissolve Texture. The key to
a good Dissolve Texture is making the image-
to-texture transition as seamless as possible.
That sometimes means making view-specific
Dissolve Textures as foliage renders differ-
ently with changes in camera and light posi-
tion.

Let's add some clouds, adjust the light, and
wrap up this tutorial. Go to the Sky Task
Mode and load the Pastel Wispy Cloud Model
from the Component Gallery. Scale the Cloud
Model's position to the current DEM bounds.
In a plan view, reset the camera to its default
position and zoom back until you can see the
shaded extent of the Cloud Model (Figure
23). As with most things 3D, more clouds
take longer to render, so we only want them
where the camera can see them. Set Bounds
in a View in the Cloud Model Editor. WCS
tells us that the next two points clicked in a
view will be the new bounds. Click one corner
behind the Wukoki View SW camera, north-

Wukoki Vie
nd Effect.

w SW view, L"»".ijf.'?-?l‘.kl. NM
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east of the camera icon in the plan view. : glassary

Click the opposite corner in the view
direction to the southwest

Let's face it, there are just too many acronyms in

This is high desert with light-colored ~ terrain animation. Explanations are provided as a

ground, so go to the Light Task public service.
Mode and open the Light Editor to
the Color & Shadow page. Click 1-degree DEM DEM covenng 1 degree of latitude and 1

the Light Color & Intensity color
well to open its Color Editor. _
Increase the Intensity to 150% : 15-minute DEM DEM covering 15 minutes of latitude and 15
to brighten the scene a little. minutes of |°"Q'tUde

Rem.jer R o S_W AD Anno Domini, Latin, "Year of God" translated literally.
preview and your scene Is 1 1 t 1 1

ready for pueblo construc-  ASCIl American Standard Code for Information Exchange

degree of longitude.

22:1 N eit?]%\sy ASCII DEM A DEM consisting of blocks of profiles (strips) of
the story tumns out/.’ elevations and georeferencing information stored in a text format

Degree (latitude) Degrees of latitude are parallel so the distance
between each degree remains almost constant. Each degree of latitude
is approximately 69 miles (111 km). 1 degree = 60 minutes = 3600
seconds

Degree (Iongltude) 1/360th the Earth's cnrcumference at the equator
Unlike latitude, lines of longitude converge at the poles so the distance
between degrees of longitude decreases as you travel from equator to pole.
A degree of longitude is approximately 69 miles (111 km) at the equator.

DEM Digital Elevation Model. A generic term for terram data flbes which:
come in a dizzying array of flavors.

DRG Dlgrlal Ras’ter Graphic
GIS Geographlc Information System Geographnc data wlth a database twist

SDTS Spatial Data Transfer Standard. The result of 12 years' intensive devel-
opment by the USGS and industry that still has some ‘of us scratching our
heads.

SDTS DEM A DEM foilowmg the Spatlal Data Transfer Standard

 Triassic Period First period in the Mesazoic Era, tastrng from approximately
250 to 202 million years ago. F'opular1y known as the Age of Dinosaurs and
prequel to the Jurassic.

USGS United States Geological Survey
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AT THE END
OF OUR LAST
SHOW, WE HAD
A MODERN DAY WUKOKI READY FOR
OUR TRIP BACK TO THE 12TH CENTURY
AND PUEBLO CONSTRUCTION, WE'LL NEED
SOME ADDITIONAL CUSTOM COMPONENTS, SO
VISIT HTTP./ /WWW.CHERBA.COM/RESOURCE/KF33
AND DOWNLOAD THE COMPRESSED PACKAGE. COPY THE
CONTENTS OF THE UNCOMPRESSED WCS FOLDER TO YOUR
WCS FOLDER.

Figure 1. Current day Wukoki site at the end of Part 1.

A
couple of
obvious
environmental
factors were
different back then.
According to pollen
studies, the climate was
wetter. We'll increase the
understory grass and bush
density, add a few Oak trees,
increase the overstory Pinyon Pine height, and add Ponderosa Pine. Go to the Light Task Mode, open the Wukoki Sun Light Editor
> Color & Shadow page, and decrease the color intensity to 100%. Switch to the Land Cover Task Mode, open the Upper Sonoran-
Pinyon WNM Ecosystem Editor > Material & Foliage page, and edit the Understory Ecotype. On the Ecotype Editor > Ecotype page,
increase the density to 20 stems per unit area, in this case, per square meter.

Turn to the Groups page and enable the Oak foliage group. The ecotype height range is set from 1 to 2 meters. We'd like Qak up to 6
meters tall, so increase the Group Height to 300%. Reduce the Group Density to 0.01%. This may seem small, but keep in mind that
the ecotype density is 20 stems per square meter. 0.01% translates into one Oak per 500 square meters. Select the Grass group and
increase its Group Density to 100%. We don't want the rendered Desert Bush group density to change much, so reduce it to 12%.

Oak prefers more moist soil, so we'll restrict it to locally depressed areas in the terrain, Create a Group Density texture and select
Dynamic Parameter from the Selected Element dropdown list. Choose Relative Elevation from the Parameter dropdown list. Relative
Elevation is negative in valleys and positive on ridges. Change the Input Low to -10 and the Input High to 0. Change the Out Low to

100% and the Out High to 0%. For relative elevations of -10 and below, the texture will return a 100% value of the group density. For rel-
ative elevations of O and above (flat and ridges), the texture will return a 0% value of the group density. Close the Texture Editor and copy
Group Density texture; we'll need it again shortly.

lkin the Ecosystem Editor, edit the Overstory Ecotype. On the Ecotype Editor > Ecotype page, increase the Maximum Height to 6
sand the Minimum Height to 2 meters.
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Figure 2. Shadow vector (black triangle) around the
Wukoki Plan.1 camera (yellow icon)
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Go to the Groups page and add a
Ponderosa Pine foliage group. Increase the
Group Height to 150% and change the
Group Density to 50%. We'll restrict
Ponderosa Pine to the same valleys as the
Oak. Select the Group Density Texture
Operations button and Paste Texture. Select
Group Density as the target in the pop-up
window and apply the texture.

Turn to the Objects page and add five Image
Objects. Add the Ponderosa1, Ponderosa?2,
Ponderosa3, Ponderosad, and Ponderosab
images from the WCS\Components\
Image\Foliage\Conifer folder.

One last thing and our time travel terrain is
ready. Sunset Crater had recently erupted,
showering the area with cinders and ash.
That means we need to pepper the land-
scape with cinders. Load the Wupatki NM
1150 Ground Effect, enable it, and disable
the Wupatki NM Ground Effect we've been
using. The new ground effect has added a
self-opaque black multifractal texture to
each slope material.

Let's add some shadows. Reload the
Wukoki Plan camera from the Component
Gallery > Cameras > Keyframe32 section, It
will come into WCS as Wukoki Plan.1
because we've already got a Wukoki Plan
camera. Go to the Light Task Mode, select
the Shadows category in the Scene-At-A-
Glance, and create a new shadow compo-
nent from the icon toolbar. Digitize a vector
around the Wukoki View SW camera.
Shadows take time to generate and we
want the best quality for our quality-setting
buck so we won't waste time with shadows
we can't see. (Figure 2)

Shadow components control shadows cast
and received by the terrain and foliage. Go
to the Shadow Editor > Cast Shadows
page and enable Cast. By default, the ter-
rain is always set to receive shadows.

Up to now, we've been rendering with
Variable Fractal Depth (Terrain Parameter
Editor). For accurate shadow maps with
foliage shadows aligned with the casting
foliage, we need to use Fractal Maps, also
called Fractal Depth Maps and FDMs, The
fractal map generator uses enabled Render
Job cameras to create FDMs. Go to the
Render Task Mode and add a Render Job
and Render Options. For easy identification,
I suggest using the camera name to identi-
fy render jobs and options, in this case,
Wukoki View SW. Open the Wukoki View
SW Render Job and assign it the Wukoki
View SW camera and Wukoki View SW
Render Options. Choose a convenient File
Qutput size and format in the Render
Options, although it's not necessary for
FDM generation.

Now we can open the Terrain Parameter
Editor, choose Fractal Maps, and Create
Fractal Maps. Confirm O as the first and last
frame to scan. After the FDMs are generat-
ed, WCS will tell us the maximum fractal
depth found and suggest a fractal depth for
rendering. In this case, a fractal depth of 3
was suggested but we'll stick with 5 to
maintain the foreground detail we've grown
accustomed to. Fractal maps show up as
FRD files in the Wukoki projects folder with
the same root name as the elevation files to
which they correspond.

Figure 3. Detail of Wukoki View SW render showing shadow offset faceting

ISSUE 33 / JUNE - JULY 2003

Open WCS Render Control, disable all ren-
der jobs but Wukoki View SW and render.
We could have run a preview render but
they aren't as accurate as the real thing,
especially where shadow offset is con-
cerned. Preview renders often exaggerate
shadow offset problems and may cause
you to overcompensate, thereby giving up
shadow detail unnecessarily. Figure 3 is a
detail from a 1440x960 render and shows
the black triangular facets typical of a shad-
ow offset value that is too low. (Figure 3.)

Go to the Shadow Editor > Cast Shadows
page and increase Shadow Offset from
Terrain to 1.5 meters. There isn't any magic
number here; you just have to gradually
increase shadow offset until the facets dis-
appear. Shadow facets are gone in Figure
4, the landscape looks great, and we're
ready for the pueblo. (Figure 4.)

Let's get organized for LightWave work. |
like to keep all project files together, so cre-
ate images, objects and scenes folders in
your WCS Wukoki project folder.

We'll export the terrain around the pueblo
site as a LightWave object for reference.
Go to the Render Task Mode and add a
new camera from the Component Gallery.
Load the Wukoki Plan CM camera from the
Keyframe33 tab; don't scale its position to
the current DEM bounds. Go to the Land
Cover Task Mode and add a new color map
from the Component Gallery. Load the
Wukoki Plan color map from the
Keyframe33 tab. Open a Wukoki Plan CM
camera view and render a preview.

(Figure 5.)
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Figure 4. Wukoki View SW with a shadow offset
of 1.5 meters

Wukoki Plan CM - Wukoki Preview Options

Figure 5. Planimetric view of pueblo location
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Figure 6. Scene Export set up for DEM export to
LightWave object Open Modeler > General
Options and change the Content Directory to the
WCSProjects\Wukoki folder.

Go to the Vector Task Mode. Select the
Vectors category in the Scene-At-A-Glance,
and create a vector from the icon toolbar.
Left-click once in the center of the Wukoki
Plan CM view, right-click to stop digitizing,
and name the vector Wukoki Pueblo, Don't
waorry about where the vector is; we'll repo-
sition it momentarily. This vector will give us
a LightWave modeling reference and allow
for precise 3D Object import atop the WCS
hilltop. Open the Vector Editor to the
Selected Points tab in one matrix cell and
the Wukoki Plan CM Camera Editor to the
Position & Orientation page in another. Copy
the Wukoki Plan CM camera latitude and
paste it into the vector X (Lat N-S) field.
Copy the Wukoki Plan CM camera longi-

tude and paste it into the vector Y (Lon W-
E) field. Change the vector Elevation to
1461 meters, which will be floor level in the
pueblo.

Go to the Render Task Mode, add a new
Render Job, and name it Wukoki DEM.
Select the Wukoki Plan CM camera from
the Camera dropdown list, add a new
Render Options, Edit and name it Wukoki
DEM. Bring the Wukoki Plan CM Camera
Editor forward and move it aside if it's cov-
ering the Render Options Editor. The
Camera Editor > Lens page shows a view
width of 50 meters. To render a DEM with
a grid size of 1 meter, enter an image size
Width of 50 on the Render Options Editor >
Size & Range page. This will cause each
pixel to be rendered as a DEM grid cell that
is 1/B0th the size of the camera view width,
in this case, 50 meters. 50 meters divided
by 50 pixels is 1 meter per pixel (grid cell).
Open the Database Editor, select one of the
active DEMs, and go to the Extent tab. For
DEM rendering to an ELEYV file, think of the
Pixel Aspect as the Grid Aspect It's the
ratio of the width of the grid cell to its
height.

Pixel Aspect = Grid WE / Grid NS

If you don't get this right, the rendered DEM
grid ratio will be different than the original
DEM ratio, i.e, your new DEM will not
match the original. We don't want to make
that mistake here because our LightWave
pueblo will be modeled on the rendered
DEM and has to fit neatly in place atop the
original DEM. For our rendered DEM:

Pixel Aspect = Grid WE / Grid NS =
100058037 / 10.0044839 = 1.00013..
(Callit 1)

Go to the File Output page, add an Output
Event, and choose the WCS DEM format.
We're warned that this format only works
with planimetric camera views, which is the
kind of camera we're rendering. Name it
Wukoki Plan CM and reduce the frame dig-
its value to 0. Go to the Enabled 1 page
and disable Other Foliage in the Vegetation
section. If you don't, Ecosystem foliage will
be rendered as knobs on the DEM.-Greate

-a-RenderJob-named Wikoki DEM-seleet
Mukaoki Plan-Ch-rem-the-Camera-drop-
down listand choose Wukoki-DEM-frem
the RenderOptionsist
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Clone the Wukoki DEM Render Job and
Render Options. This job will render a back-
drop image for reference in Modeler. Open
the cloned Render Job, rename it Wukoki
DEM TIF, and select the cloned Render
Options from the dropdown list. Edit the
cloned Render Options and rename it

L
Wukoki DEM TIRGo 1o the File Output ”%r

page, add a nt, name it f 226
Wukoki Plan CM, and reduce rame
digits value to 0. Open WCS Render che z: .
Control, make Wukoki DEM and Wukoki ~ 7%&
DT
fo 77—

DEM TIF the only enabled render jobs,
check the settings and render.

Create a new WCS project and name it
whatever you want. We'll only use it to
export the newly rendered DEM as a
LightWave object. Import data when asked
and load the Wukoki Plan CM.elev file from
the WCSFrames folder. After import is com-
plete, the Status Log will show a maximum
elevation of 145854 meters, which is the
highest point in this section of terrain. The
DEM doesn't fill the view north to south
because it's using the Preview Options,
which defaults to a 09 Pixel Aspect.

Choose Export Scene from the File menu.
Select LightWave 3D 7x as the Export File
Format, select Export DEM Only, and point
the Content Directory to
WCSProjects\Wukoki\objects. Export the
DEM. Select the DEM to be exported in the
'DEM file to export' file requester, in this
case, Wukoki Plan CM.elev. Confirm the
name of the new LightWave object DEM
name and path in the 'LW Object path/file'
file requester. That's it for this WCS project.
(Figure 6.)

Open Wukoki Plan CMIwo in Modeler. The
southwest corner of the terrain will import
at the origin. The 10-meter terrain grid is
clearly visible at this scale. Center the ter-
rain object at the origin. Open Display
Options to the Backdrop page, select the
viewport that corresponds to your top view
(TL by default), and load the Wukoki Plan
CM.tif image. Automatic Size it.

Recall that we assigned the WCS Wukoki
Pueblo vector an elevation of 1461 meters.
This is where our LightWave model origin
needs to be, too. Select the uppermost point in
the terrain and open point Info from the
Display menu; the Y value is 36043 meters. If
the Modeler origin corresponds to an eleva-
tion 1461 meters in WCS and the top of
this terrain section is 1458.54 meters, then

KEYFRAME
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Figure 7. Reference DEM, Wukoki Rock, and Wukoki
Pueblo objects

the top of the terrain in Modeler needs a Y
value of -(1461-145854) or - 2.46 meters.
Move the terrain down 6.0643 meters to
drop the terrain top from 3.6043 to - 246
meters.

The LightWave models we need are includ-
ed in the resource download: Wukoki Rock
W and Wukoki Pueblo W. The 'W' tagged
onto the end reminds me these are WCS-
ready objects collapsed onto a single layer.
WCS does not import multiple layer objects
and will tell you so when you try.

The rocky platform on

which the

pueblo was built and the pueblo itself are
separate objects to allow control over object
settings (like shadows) in WCS. Load the
objects into layers in the Wukoki Plan CM
object to get an idea how everything fits
together (Figure 7).

Relative to the terrain resolution, this pueblo
is a small feature on the landscape. A highly
detailed model would be incongruous with
the style we've already established for the
landscape. The rocky outcrop and pueblo
have enough detail to define the structures
and blend them stylistically into the scene.
LightWave objects need little preparation for
import into WCS, with a notable exception.
Boolean operations can leave odd polygons
that WCS has problems understanding,
especially subtractions. Triple polygons in
the WCS object version to avoid problems.

Load the Pueblo View North and Pueblo
View SW Render Jobs from the Component
Gallery > Keyframe33 section. Render Job
components import with their associated
cameras and Render Options. You'll see the
reason for this shortly. Don't scale the cam-
era positions to the current DEM bounds.
Open a Pueblo View North view. Go to the
Vector Task Mode and open the Wukoki
Pueblo Vector Editor. We need a copy of
this vector for the rock object so Create
Copy and name it Wukoki Rock.

Go to the 3D Object Task Mode and add a
generic 3D Object. Deselect Render a
Geographic Instance on the 3D Object
Editor > General page; we'll use a vector to
place the object. Select the Load
Component from Disk button along the right
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margin of the editor, navigate to the
WCSProjects\Wukoki\objects folder, and
open Wukoki Pueblo Wiwo. The 3D Object
name will update with the loaded object
name. Go to the 3D Editor > Size & Position
page and make the geographic position
Relative to Vector. Clone the Wukoki Pueblo
3D Object in the upper Scene-At-A-Glance
and load Wukoki Rock Wiwo.

Slide down the lower Scene-At-A-Glance
pane and expand the Vectors category.
Click, drag and drop the Wukoki Pueblo vec-
tor on the Wukoki Pueblo 3D Object in the
upper Scene-At-A-Glance pane. When
WCS asks if you want to use the vector for
position or alignment, choose position. Click,
drag and drop the Wukoki Rock vector on
the Wukoki Rock 3D Object The 3D
Objects are set to box preview, so that's
what we see in the Pueblo View North view.

There are a few changes we need to make
to 3D Object materials right off the bat.
Open the Material Editor > General page,
change Shading to Phong, and increase the
Smoothing Angle to 89°. Change the
remaining material shading and smoothing
angles.

The Wukoki Rock object has three materi-
als: Rock Bottom (unseen), Rock Sides and
Rock Top. We want Rock Sides and Rock
Top to blend into the surrounding terrain
since the rock outcrop is just an extension
of it. The Moenkopi 5 Cliff material in the
Wupatki NM 1150 Ground Effect renders
the exposed rock around the Wukoki site.
Go to the Land Cover Task Mode and open
the Ground Editor to its Material page.

Figure 8. 3D Objects rendered at Normal (left) and High (right) Render Quality




Figure 9. 3D Object shadow offset at 0.05 m (left) and 1.1 m (right)

Select the Moenkopi 5 Cliff material, click
the Diffuse Color Texture Operations button,
and Copy Texture. The 3D Object Material
Editor should still be open, it's just hidden.
Go to the Window menu and select the
Material Editor to bring it forward in this task
mode. Cycle through the materials with the
Edit Next button until you get to the Rock
Sides material. Turn to the Properties 1
page; select the Diffuse Color texture button
and Paste Texture. Select Diffuse Color as
the target in the pop-up copy window.

Edit the texture you just copied. WCS 6
added the Coordinate Space option, which
can cause confusion when copying terrain
textures to 3D Objects. This texture was
copied from a Ground Effect so it retained
the terrain XYZ orientation and coordinate
space, where Z is elevation. However, the
thumbnail shows the texture in object space
where Y is the elevation. We can leave
everything as is and the texture will render
correctly on the 3D Object material. | prefer
to work in object space where thumbnails
show proper orientation and axes are con-
sistent with LightWave convention. Select
Object Cartesian from the Coordinate Space
dropdown list, change the Size Y value to 1
meter, and Z value to 1000 meters.

Select the Material Editor Diffuse Color tex-
ture button and Copy Texture. Cycle to the
Rock Top material and paste the texture to
its Diffuse Color. Edit the Rock Top diffuse
color texture and change the X, Y, and Z
size values to 50 meters. If you can't see

the Ground Editor, move the Material Editor
aside. Turn to the Rock Top Material Editor >
Properties 2 page and add a bump map tex-
ture. Load the Wukoki Rock Bump material
from the Component Gallery > Keyframe33
tab. Copy the Rock Top bump map texture,
click the Edit Previous button, and past it
onto the Rock Sides bump map texture.

The Wukoki Pueblo has five materials: Base
(unseen), Doorway, Ladder, Roof Beams,
Roof Exterior and Exterior Wall. We won't
get close enough in renders to see any
detail in the doorways, ladders, and roof
beams, so we'll stick with the diffuse colors
chosen for that purpose. The roof and exte-
rior walls will share the same diffuse color
and walls will have a hint of abode bump.
Open the Wall Exterior Material Editor and
load the Wukoki Exterior Wall material from
the Component Gallery > Keyframe33 tab.
Change the Roof Exterior material diffuse
color to R 216, G 137 and B 092. That
takes care of the rock and pueblo object
materials.

Before rendering, don't forget that we've
added three new cameras and need to
regenerate fractal maps. If you forget, WCS
will remind you when it runs out of FDMs
during rendering. Open the Terrain
Parameter Editor and increase the
Maximum Fractal Depth to 7. The Render
Jobs we loaded with the new cameras are
ready to go, so Create Fractal Maps. Render
a Pueblo View North preview. If you get
large terrain polygons in the background,
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delete all FRD files from your Wukoki folder,
regenerate fractal maps, and render another
preview.

You may not notice it in preview renders, but
larger renders will show a sharpness
between 3D Object elements and between
3D Objects at the normal render quality
default. Go to the 3D Object Editor >
General page for each object and change
Render Quality to High. Figure 8 shows
details from 1440x960 renders of the view
in Figure 11. The left section was rendered
at a 3D Object Render Quality setting of
Normal and edges show a roughness. The
right half was rendered at the High render
quality and shows the edge softening of
additional render passes. (Figure 8.)

Now let's add 3D Object shadows. The ter-
rain around the pueblo is set to receive
shadows via the Wukoki Foliage shadow
component we created earlier. If you open
the Shadow Editor > Receive Shadows
page, you'll see the terrain receives shad-
ows from everything but volumetrics. To
make the 3D Objects cast shadows, go to
the 3D Object Editor > Shadows page and
set the pueblo and rock to cast shadows.
Change the Shadow Map Quality to Very
High. Render another Pueblo View North
preview.

As with the terrain shadows early in the
tutorial, the default shadow offset value
turns out to be too low for the 3D Objects.
Increase the Shadow Offset from Object
value until renders no longer show shadow
artifacts. You don't want to increase offset
any more than necessary because it moves
shadows away from features casting them.
Try values of 1.1 meters for the pueblo and
1.6 meters for the rock object. This was the
primary reason the pueblo and rock outcrop
were imported as separate objects. Figure 9
shows the effect of shadow offset. The left
view was rendered at the 0.05 meter offset
default. Shadows are attached to their cast-
ing elements (e.g, roof beams and ladder)
but walls in shadow show artifacts. The rock
object reveals some polygon edges. The
right view was rendered at a shadow offset
of 1.1 meters. Shadows have detached from

their casting elements but artifacts are gone.

(Figure 9.)
While we're on the subject of shadows, you

may have noticed that the foliage shadows
appear blocky in the Pueblo View North
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Figure 10. Shadow map quality comparisons. Normal
(A) and Very High quality (B) in 700,000 m_ vector
area. Normal (C) and Very High quality (D) in 40,000
m_ vector area.

Figure 11. Pueblo View North with 3D Object shadow
casting enabled.

Figure 12. Pueblo View SW before terraffector rock
dome added.

Figure 13. Pueblo View SW after terraffector rock dome
added.

KEYFRAME

preview renders. The Wukoki Foliage shad-
ow component has normal shadow map
quality and is controlled by a vector covering
about 700,000 square meters. Figure 10A
shows a planimetric view of the foliage
shadows west of the pueblo. Shadow map
quality is a function of both quality and area.
Figure 10B is the same vector area ren-
dered at a shadow map quality of Very High.
Figure 10C is the same shadow component,
normal quality, but attached to a vector
encompassing a much smaller area, about
40,000 square meters. Figure 10D shows
the smaller vector area rendered at Very
High shadow map quality. Here you can see
the effect of the 1.5 meter shadow offset
The moral of the story? Make your foliage
shadow vectors cover as small an area as
necessary and use the highest shadow map
quality setting your memory will allow.
(Figure 10.)

Our final render will be back at the Wukoki
View SW camera we created the shadow
vector for, so keep the existing vector and
change the Shadow Map Quality to Very
High. Render another Pueblo View North
preview (Figure 11). Shadow offset is a
good news-bad news story. You eliminate
shadow artifacts but increase shadow sepa-
ration from the shadow casting features.
When accurate self-casting shadows are
required, go the compositing route and ren-
der your 3D Objects in LightWave. We won't
be rendering close enough to the pueblo to
see the offset, so it's not an issue in this
project. (Figure 11)

Open a Pueblo View SW view and render a
preview (Figure 12). We need a dome-
shaped section of rock under the northeast
end of the pueblo. This could have been
modeled in LightWave, but there's a disad-
vantage to terraforming with 3D Objects
that | haven't mentioned. While we can copy
Ground Effect materials to 3D Objects, we
can't make Ecosystems grow on them.
Fortunately, a dome feature is easy to ter-
raform in WCS. (Figure 12.)

Open a Wukaki Plan CM view and render a
preview to digitize on. Go to the Terrain Task
Mode, select the Terraffectors category in
the Scene-At-A-Glance, and create from the
icon toolbar. Terraffectors are normally linear
features, but a single vertex terraffector cre-
ates a point effect. Left click a vertex in the
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plan view between the two northeast rooms,
right-click to stop digitizing, and name the
vector and terraffector Wukoki Dome. Go to
the Wukoki Dome Vector Editor > Selected
Points tab and change the elevation to
1463 meters. This may seem a bit high, but
once we get done with the terraffector it'll
be just right.

Go to the Terraffector Editor > Elevation
page and select Relative to Vector Elevation
and Increase Only. Edit Cross-section Profile
to open the Profile Editor. This terraffector
uses a single point so the profile shows the
curve that will spin around it to modify the
terrain. Add 5 points to the profile and
select the rightmost point. Enter a distance
26 meters, a value of -14 meters, and a ten-
sion of 1. Select the next point left in the
profile and enter its values from the table
below. Repeat the process for the remaining
points in the profile and keep the changes
when you're done.

Distance Value Tension
26'm -14m 1
13m -7m 0

5m -2m 05
2m -05m -1
1m 0 0

A Pueblo View SW preview render shows
the rocky dome we want, but it's a little too
perfect. Features like this do occur in nature,
but this is not one of them. Go to the
Terraffector Editor > Elevation page and
create an Effect Intensity texture. Load the
Wukoki Dome Tfx Intensity texture from the
Component Gallery > Keyframe33 tab. The
effect intensity texture uses a soft fractal
noise element to modify the terraffector.
(Figure 13)

Ecosystems don't respect 3D Objects and
will render foliage within them if left to their
own devices. Go to the Land Cover Task
Mode, select the Ecosystems category, and
create from the icon toolbar. Digitize a vec-
tor around the rock object in the Wukoki
Plan CM preview render. Right-click when
you're done and name it Eco Exclusion. Tum
to the Ecosystem Editor > Material &
Foliage page and make the Material Ground
Overlay Transparency 100%. We have no
Ecotypes so this will render Ground Effect.
The Ecosystem is vector bounded which
gives it render priority over the Environment
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